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RM Billing Secondary Receipting Training Program 
 

Morning Courses 
 

Time Contents 

8.45am Coffee and Registration 

9.00am  Overview of RM Billing 

 Receipting Methods 

 Individual Receipts 

 Billing Item Bulk Receipts 

 Charges and Contribution Receipts 

 Printing Receipts 
 

10.15am Morning Tea 

10.30am  Receipt Reports 
o Daily Banking 
o Receipt Summary 

 Correcting Errors 

 Export the Receipt Batches 

 Processing Refunds  

 Unallocated Credit 

 Following up unpaid debt 

 Questions 

12:00pm Close 

 
 

Afternoon Courses 
 

Time Contents 

12.30pm Coffee and Registration 

12.45pm  Overview of RM Billing 

 Receipting Methods 

 Individual Receipts 

 Billing Item Bulk Receipts 

 Charges and Contribution Receipts 

 Printing Receipts 
 

2.15pm  Afternoon Tea 

2.30pm  Receipt Reports 
o Daily Banking 
o Receipt Summary 

 Correcting Errors 

 Export the Receipt Batches 

 Processing Refunds  

 Unallocated Credit 

 Following up unpaid debt 

 Questions 

3.45pm  Close 
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Training Outcomes 
 
At the end of the RM Billing Primary Training Program participants should be able to: 
 

 Create receipt batches 

 Understand and apply the various methods for receipting 

 Issue receipts for students and customers 

 Record bulk student payments 

 Reverse a billing item 

 Reverse a receipt 

 Refund receipts 

 Manage Timetable changes in Billing 

 Produce receipt reports 

 Allocate unallocated credit 

 View outstanding debt 

 Print Statements 
 
 

TRAINERS USE TRAINING DATA 2 and RM FINANCE DEMO  
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1 Introduction to the RM Billing Module 
 
RM Billing is a module that is available within Integris.  When the RM Billing module is added, a 
new sidebar called RM Billing appears. 
 
This module allows both students and external customers (companies and/or individuals external 
to the school environment) to be billed for any type of cost.  Students can be billed for subject 
related costs, charges and voluntary contributions, other optional costs, voluntary approved 
requests, camps and excursions etc. Customers can be billed for items such as hire of the school 
hall etc. 
 
Student details and those of their related contacts, (e.g. Parent/Guardian 1, Parent/Guardian 2 
etc.), should be accurate within the Administration module before adding the RM Billing module.  
Each student should have one contact nominated as the person who will be responsible for paying 
their fees.  Correspondence generated from RM Billing - such as Charges and Contributions 
Sheets and Statements - will be addressed to the first contact marked for Fees Billing for each 
student in the Administration module. RM Billing will draw on student and contact data held in the 
Administration module. 
 
The RM Billing module can be used in conjunction with the Timetabling module (optional).  Student 
subject preferences from Timetabling are available in RM Billing.  Costs for each subject can be 
entered in RM Billing and students can be billed according to the subjects they have chosen to 
study.  The bulk billing facility enables students to be billed en masse for any other types of costs.  
 
RM Billing supports several methods of receipting (including bulk receipting) and provides a suite 
of useful reports. 
 
RM Billing can also be linked to RM Finance. A set of Billing Codes created in RM Billing provide 
the link to the budget and analysis codes used by the school in RM Finance. Receipts entered in 
RM Billing can be automatically exported to RM Finance against the correct budget and analysis 
codes.  
 
The following diagram illustrates how RM Billing interacts with other Integris modules. 
 
 

 
 

 

ADMINISTRATION MANAGER 

 

TIMETABLING 

 

RM 
BILLING 

 

RM FINANCE 
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1.1 Logging on to the System 

 

Activity: Logging On 
 

 Double click on the RM Billing Secondary Receipting icon on your desktop 
 

 
 

 Type ADMIN into the User Name field 

 Press <Tab>  

 Type keys into the Password field 
 

 
 

 Click on Login, or press <Enter> 
 

Note: In schools, each user has their own user name and password, which enables access 
to particular sections of the software as determined by the school administration. 

It is strongly recommended that you change your password regularly. 
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1.2 The File Menu 

The file menu may be accessed by clicking on File in the top left of your screen. 
 

 
 

 Password enables the user to change his or her password.  For security purposes, it is 
recommended that this is done regularly. 

 Change User should be used to ensure that each person accessing Integris does so under 
their own user name and with their personal levels of access. 

 Lock Terminal may be used if the user needs to leave his or her computer temporarily, does 
not want to log off and does not want to allow access to anyone else.  Unlocking the terminal 
requires the user to enter his or her password again. 

 Report Destination allows the user to choose where to send any report created in Integris.  
The options are displayed below. 

 
 

Activity: The File Menu 

Top Toolbar > File 

View each of the following items in the File menu 

 Password 

 Change User 

 Lock Terminal 

 Report Destination 
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2 Accessing Help 
 

Activity: Accessing Help 

Top Toolbar > Help > Help Contents and Index 

 Click Help in the top toolbar 

 Select Help Contents and Index 
 

  
 

 Highlight Integris RM Billing Help 

 Click Help 

 View the manual  

 Close the manual and Help 
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Activity: Logging onto RM Finance 
 
All RM Billing Users must log onto RM Finance before any processing can be undertaken. 

RM Billing>Students  

 Select User Name Manager Corporate Services 

 Enter password Keys 
 

 
 

 Click on   
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3 Brief Overview of RM Billing 

3.1 Students 

The Students section is the ‘heart’ of the RM Billing module. When the window opens, all students 
on the current roll are displayed along with their current year group and current form. 
 

 

3.1.1 Student Icons 

The following icons are available on the Student List screen. 
 

 
Standard Student Find Tool 

 
Load Current Students – Displays all students on the current roll 

 
Open Details – Opens the drill down facility for the selected student 

 
Print – Prints all students displayed in the list view 

 
Print Selected – Prints all selected (highlighted) students in the list view 

 
Hide Selected – Hides all selected students 

 
Hide Unselected – Hides all unselected students 

 
Show/Hide Deleted Students – Displays students who have been deleted from 
the Administration module but still have a record in RM Billing 

 

3.1.2 Using the Student Window Icons 
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Activity: Using the Student Window Icons 

RM Billing > Students 

 Click Find Student  

 Select Year Group 9 to display only the Year 9 students 

 Click Find > Select > Yes 

 Click Load Current Students  to display all students who are on the current roll 
 

 Highlight any student and select Open Details  

 Click Return to View  

 Click Print List  

 Close the Student Summary Report 
 

 Hold <Ctrl> and select 5 students from the list 

 Click Print Selected  

 Close the Student Summary – Selected Items Report 

 Click Hide Selected  to hide those selected students 

 Hold <Ctrl> and select 5 students from the list 

 Click Hide Unselected  to only view those selected students 

 Click Load Current Students  to display all students who are on the current roll 

 Click on the Notes Header twice to bring all students with notes to the top of the list 
 

 
 

 Highlight the two students with notes 

 Click on For Selected > Print Notes and OK to send to the screen 

 View the notes and close 
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3.1.3 Quick Search on Student Surname 

A quick search on student surname is available on this window. For example, if you click on the 
first student in the list and then type the letter ‘B’ the cursor will move to the first student whose 
surname begins with ‘B’. If you type the entire surname (e.g. BORN), the first student in the list with 
that surname will be highlighted. 

3.1.4 Drill Down Facility 

Drill down functionality is instigated by double-clicking or pressing <enter> on a student name. 
Note that all transactions will be attached to the student’s record. The name of the fees biller is 
also attached to this record. 

3.1.5 Red Fields 

The red fields at the top of the screen are scroll fields and search fields.   

 Left mouse click to view the next student.  

 Shift and left mouse click to view the previous student.     

 Right mouse click to enter the name of a new student to view.   

 It is recommended that users work with smaller groups of students and this method is used 
to navigate between students. 

 

 

Note: It is advisable (and quicker) to search for students from within the drill down section 
rather than always returning to the front screen. Either the red fields or the binoculars can 
be used. 

3.1.6 Return to View 

Use the blue circular arrow   to return from the drill down display to the front list screen.   
Selecting return to view will recalculate student balances.    
 

Activity: Searching for Students 

RM Billing > Students 

 Type the Surname Born 

 Double click Corrina Born 

 View the tabs available in the student window 

 Click on the red Surname field  to scroll through the student names 

 Right click in the Surname filed and type Brown press <Enter>. The first student with that 
surname is displayed 

 Close the Student details window 
 

Note: We will use the student details window in depth later in training. 
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3.2 Customers 

This section is used to bill customers who are external to the school (i.e. not 
parents/guardians/students). For example the local theatre group who wish to hire the school hall 
for their rehearsals. 
 
Customer records can be created at any time by the user.  
 
The functionality available in the Customers section is very similar to the functionality available in 
the Students section. 
 

 
 

3.2.1 Customer Icons 

The following icons are available in the Customers section. 
 

 
Load All – Displays all customers in the list view 

 
Open Details – Opens the drill down facility for the selected customer 

 
Print – Prints all customers displayed in the list view 

 
Print Selected – Prints all selected (highlighted) customers in the list view 

 
Hide Selected – Hides all selected customers 

 
Hide Unselected – Hides all unselected customers 

 
Add Customer – Allows a customer record to be added 

 
Edit Customer – Allows a customer record to be edited (restricted editing only if 
there are transactions against the customer) 

 
Delete Customer - Allows a customer record to be deleted (only if there are no 
transactions against the customer) 
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3.2.2 Quick Search on Customer Name 

A quick search on Customer Name is available on this window. For example, if you click on the first 
Customer and then type the letter ‘B’ the cursor will move to the first Customer whose name begins 
with ‘B’. If you type the entire Customer Name then that Customer Name will be highlighted.   
 

3.2.3 Drill Down Facility 

Drill down functionality is instigated by double-clicking or pressing <Enter> on a Customer Name. 
 

3.2.4 Red Field 

The red field at the top of the screen is a scroll field and a search field (see Students section). 
 

3.2.5 Return to View 

Use the blue circular arrow   to return from the drill down display to the front list screen. 
 

3.3 Billing Items 

This section is used to create Billing Item batches. These batches will hold the billing item 
transactions once the students have been billed. The standard icons which have already been 
discussed are available on this window. 
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3.4 Receipts 

The Receipts section is used to create Receipts batches. These batches will hold the receipts 
entered into RM Billing. The standard icons which have already been discussed are also available 
on this window. 
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3.5 Reports 

A variety of standard reports are available from this section as illustrated below. These will be 
covered as we progress through the training course. 
 

 
 

3.6 Parameters 

Parameters can be set to customise the RM Billing module for use in your school. More detail will 
be provided on the relevant parameters during the course of this training. 
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3.7 Utilities 

The Utilities section provides a set of standard routines/processes that need to be run at certain 
times within the RM Billing module. Again, the relevant processes will be covered as we progress 
though the training. 
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4 Receipting 
All receipts entered into RM Billing must be placed into a receipts batch.  Receipts batches must 
be created before the receipts are entered.   
 
The following conventions should be followed when creating receipts batches.    
 

4.1 Separate Receipts Batches 

Create separate batches for the following options: 
 

 General Banking (daily takings – cash and cheques) 

 Electronic Funds Transfers which include electronic credit card payments 

 Direct Deposits, such as payments from Centrelink or Family and Children’s Services 

 BPAY 

 Corrections  

 Refunds 

 Government Subsidies (special type of receipt – not exported to RM Finance) 

 Clothing Allowance 
 
It is important that you separate the different types of receipts. This will make reconciliation in RM 
Finance much easier.  
 
For example, a general banking batch containing Cash and Cheques should be closed off when 
you are ready to bank the money. Then the batch total in RM Billing (which is transferred to RM 
Finance) will match the deposit amount that is taken to the bank.  When you reconcile in RM 
Finance, the same batch total will appear on the bank statement and also in RM Finance making it 
easy to reconcile.  
 
If you enter other types of receipts into the batch that are not banked, the batch total in RM Billing 
and RM Finance will not match what is on the bank statement. 
 

4.2 Naming Receipts Batches 

The Receipts batch number will be automatically created by RM Billing. It will always begin with the 
letter ‘B’ followed by a sequential 5 digit number beginning with 00001.  
 
When naming a receipts batch, the description should contain the type of batch and the date it was 
created (dd.mm.yy). 
 
For example: 
General Banking 03.03.19 
Electronic Funds Transfer 03.03.19 

Note: For receipts entered retrospectively from receipt books or Z tapes, enter the comment 
“Duplicate- original receipt #xxxx” or “Duplicate-original Z tape #xxxx” as required   

Note:  For more information log on to http://det.wa.edu.au/finance/detcms/portal/  to access 

“Procedures for RM Billing Receipts batches. 

  

http://det.wa.edu.au/finance/detcms/portal/


 

 
RM Billing Sec Receipting Training Notes 2019 20-Mar-19 

Page 23 of 102 

   © 2019 Civica Education Pty Ltd 

 

Activity: Creating a Receipts Batch 
 
Create the following two receipts batches using today’s date: 
 

 General Banking dd.mm.yy 

 Electronic Funds Transfer dd.mm.yy 
 

RM Billing > Receipts 

 Click Add  

 Enter the description and today’s date 
 

 
 

 Click OK to save 

 Repeat the process to create the Electronic Funds Transfer receipts batch 
 

 
 

 View the newly created receipts batches in the Receipts Batches List View window 
 

 
 

  The batch numbers would be recorded on the RM Finance batch register 

 Close the Receipts Batches List View window  
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4.3 Receipt Payment Types 

The following standard payment types exist in RM Billing and need to be used when entering 
receipts onto the system. 
 
CA Cash 
CH Cheque 
CR Credit Card 
EF EFTPOS 
BP BPAY 
DD Direct Deposit 
GV Government Subsidies 
 

4.4 Methods of Receipting 

There are a number of different methods that can be used for entering receipts into RM Billing.  
The method used will depend upon the circumstances. 
 

4.4.1 Receipting Methods 

There are four methods users may select from when processing receipts.  Each has features to 
assist with individual receipting needs. 
 

Receipt 
Process 

 Features Type of Payment 

Apply Subsidy Students>For Selected>Apply 
Subsidy 

Payment is 
automatically 
allocated to billing 
items according to 
business rules 

GV only 
$235 Education Program 
Allowance only  

Apply Receipt Students>For Selected>Apply 
Receipt 

Payment is 
automatically 
allocated to billing 
items 

CA, CH,CR,EF,BP,DD 

Add Receipt Student Record>Add Receipt Payment is 
automatically 
allocated to billing 
items.  Users may 
edit allocations. 

CA, CH,CR,EF,BP,DD 

Bulk Receipts Receipts>Receipt batch>Bulk 
Receipts 

Allows users to 
receipt via 
payment type. 
Users select the 
billing items to be 
paid. 

CA, CH,CR,EF,BP,DD, 
GV 
 
Ensure correct payment 
batch type is selected 

Add Receipt for 
selected Billing 
Items 

Billing Items> Batch Billing Items> 
Show Outstanding Amounts> Add 
Receipt 

Allows users to 
receipt payments 
of the same billing 
item, amount and 
payment method. 

CA, CH,CR,EF,BP,DD 
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4.4.2 Bulk Receipting via the Billing Item Batch  

This method is useful if a group of students are all paying the same amount for the same billing 
item(s).  For example, a group of students are all paying $300 for their Camp Charges. 
 
The Payment Type (e.g. Cash or Cheque) must also be the same for each group entered. 
 

Activity: Bulk Receipting via Billing Item Batch 
 
The following students have all paid in full for their Camp Charges.  Follow the instructions below 
to enter these receipts in bulk via the Billing Items batch. 
 

Name Payment Type Amount Paid 

Ryan Cooper CHEQUE 300 

Renee Dexter  CHEQUE 300 

Simon Rumble CHEQUE 300 

Jillian Sorrell CHEQUE 300 

Total Amount Paid 1200 

RM Billing > Billing Items 

 Double-click on the Year 11 Camp batch 

 Click on the Batch Billing Items tab 

 Click    (this ensures that the balances owing on the billing items after 
adjustments, if any, are displayed) 

 Click on the Student/Cust column heading to sort the list 

 Highlight all the billing items for the above students who have paid for their camp in full 
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Note: The Selected Totals Amount should match the Total Amount for all students. 

 Click Add Receipts for the selected billing items   

 Enter the General Banking receipts batch or press <Tab> for a list   

 Type in the total amount for all students of 1200 (this is the selected total) 

 Enter the payment type of Cheque or press <Tab> for a list 

 Enter a comment Year 11 Camp 
 

 
 

 Click OK 
 

 
 

 Click Yes 
 

 
 

 Click on Yes  

 Choose Receipts > OK and OK to print to screen 

 View and close the receipts 
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Activity: Review of Entering Bulk Receipts via the Billing Items 
Batch 
 
Use the same method to enter the receipts for those students who have paid by Cash. Print the 
receipts to the screen. 
 

Name Payment Type Amount Paid 
 

Ashleigh Campbell CASH 300 

Shane Casson CASH 300 

Paul Hogan CASH 300 

Total Amount Paid 900 

 
 

 
 
 
 

4.4.3 To print receipts at another time 

 Choose Students  

 Select the appropriate student 

 Choose the Receipts tab 

 Highlight the appropriate receipt in the top half of the window 

 Choose the Printer icon  
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4.4.4 Bulk Receipting for a mixture of items via the Receipts batch 

This method is useful for processing a group of receipts which are mixed in nature. For example, 
different students are paying different amounts with various payment types for different items. 
 

Activity:  Bulk Receipting With Various Payment Methods 
 
The following payments have been received. They are mixed in nature.  They are for different 
amounts, different payment methods have been used and they are for different items. 
 

Name Amount Paid Payment Type Payment For 

Ashleigh Campbell $335 Cheque Balance of account 

Michael Fulter $400 Cash Balance of subject charges 

Marc Kitchen $300 Cheque Year 11 Camp 

Damien Lambert $50 Cash Earth & Environmental 
Science 

 

RM Billing > Receipts 

 Double-click the General Banking batch 

 Select the Bulk Receipts tab 

 Click Add Receipts   

 Enter the student’s surname (or part thereof) in the Student Name field and <Tab> to select 
the student from a list 

 Enter the amount <Tab> 

 <Tab> in the items field 

 Highlight the items to be paid, click OK and <Tab> 

 Enter the payment type (or press <Tab> for a list) <Tab> 

 Enter a comment (e.g. Balance of Account) 

 <Tab> to move to the next line  

 Repeat this process for the next student 
 

 

 Once all receipts have been entered, click OK to save 

 Click Print  

 Click OK to view the Receipts 

 Close the receipts 

 Click Return to View  
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Note: If a blank line is created in error, right mouse click on the blank line and select 

 Remove line.     

 

IMPORTANT  

The receipts are not saved until the OK button at the bottom of the 
screen is clicked. It is therefore recommended that shorter lists are 

entered and saved regularly to minimise loss of data in the event of a 
power failure etc. 
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5 Government Subsidies 
The following is information regarding the changes to the Secondary Financial Assistance (SFA) 
Program.  Due to time constraints in today’s training, we are unable to demonstrate this function, 
however it is covered in detail in the RM Secondary Billing 2 day course.   

 

5.1.1 Secondary Financial Assistance Information 

 
Students qualify for Secondary Financial Assistance (SFA) if one of their parents/guardians is a 
holder of one of these eligible Concession Cards. 
 

 Centrelink Health Care Card 

 Centrelink Pensioner Concession Card 

 Veteran’s Affairs Pensioner Card (Blue Card) 
 
Parents/Guardians must complete an application form and these are then approved by the Schools 
Resourcing and Support Directorate at the Department of Education. 

5.2 Managing SFA Applications in RM Billing 

The latest version of RM Billing allows schools to complete and manage the forms and application 
process, as well as receipting of GV Subsidies.  
 
The steps in this process are: 
 

1. Application Forms are completed and printed from RM Billing 
2. Forms are signed by the Concession Card holder making the application 
3. Details of the Applications are exported to a text file 
4. The Exported files are emailed to Schools Resourcing and Support Directorate 
5. Once approved, Import Receipt text files are returned to the school 
6. Receipt files are imported into RM Billing (This creates a receipts batch for GV Receipts) 
7. Imported  Receipts are created as Unallocated GV Credit for students in the Import file 
8. GV Credit can then be allocated to the student’s Billing Items 

 
The Secondary Financial Assistance Allowances available for students are: 
 

 Education Program Allowance (EPA) for $235 

 Abstudy Supplement Allowance (ASA) for $79* 

 Clothing Allowance (CA) Payment for $115 

Note:  The Importing and Exporting of the Secondary Financial Assistance forms is covered 
in the 2 Day RM Billing Secondary course.  
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Notes: Government Subsidies must be applied to Billing Items in a specific order depending 
on their Student Billing Category.  

*The Abstudy Supplement Allowance is a top up payment for Indigenous students where 
their parent/guardian have already claimed $156 through their Centrelink payments. 

Clothing Allowance payments are classified as Parent Payments, however imported 
Clothing Allowance receipts will be imported with a payment type of (GV) where the parent 
has allocated this directly to the school. 

 
Further information on the above allowances can be obtained by contacting: 
 
Schools Resourcing and Support Directorate 
Department of Education 
151 Royal Street,  
East Perth.  WA  6004 
 
Telephone:  (08) 9264 4516 
Facsimile:    (08) 9264 5162 
 
Email:          student.allowances@education.wa.edu.au  
  

mailto:student.allowances@education.wa.edu.au
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5.3 How are Government Subsidies handled in RM Billing? 

In RM Billing a Government Subsidy is a special type of receipt.  Government Subsidies need to 
be recorded against the students in RM Billing, but unlike other receipts, the subsidy money is not 
exported to RM Finance. This is because when the Government Subsidy money is received by the 
school, it is entered directly into RM Finance as a lump sum.   

5.3.1 Rules for Applying Government Subsidies  

The Government Subsidy is applied to the billing items for the selected year for each student in a 
particular order, according to the billing category of the student. The table below shows the order in 
which the types of billing items need to be paid by the subsidy. 
 
If completing this process using the For Selected > Apply Subsidies, the software will 
automatically allocate the subsidy based on the Business Rules outlined below. 
 

Student Billing Category Priority for applying subsidies 

Kindergarten, Pre-Primary, 
Primary, Secondary (Vol,Chg) 

Voluntary, Charges, Residential, Other Optional Costs, 
Voluntary Approved Requests followed by any other 
item which has a category assigned (other than Not 
Applicable). 
 

Secondary (Chg) Charges, Residential, Other Optional Costs, Voluntary 
Approved Requests followed by any other item which 
has a category assigned (other than Not Applicable). 
 

Temporary Visa Overseas 
Students 

Temp Visa, Charges, Residential, Other Optional 
Costs, Voluntary Approved Requests followed by any 
other item which has a category assigned (other than 
Not Applicable). 
 

Adult Students Adult student costs, Charges, Residential, Other 
Optional Costs, Voluntary Approved Requests followed 
by any other item which has a category assigned 
(other than Not Applicable). 
 

Full Fee Paying Overseas 
Students 

Not applied, since these students are not eligible for 
Government Subsidies. 
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5.4 Applying Government Subsidies Manually – Discussion Only 

When any receipt is entered into RM Billing, it needs to be placed in a Receipts batch. As 
Government Subsidies are different to ‘normal’ receipts it would be necessary to create one or 
more separate receipt batches to hold the subsidies. 
 
For Example: Create a Receipt Batch for the $235 Education Program Allowance. 

RM Billing > Receipts 

 

 Click Add Item  

 Enter the description as shown below 
 

 
 

 Click OK 
 
This process would be repeated if creating a Clothing Allowance Batch 
 
 

Note: Batch numbers are automatically created by RM Billing and will start with B’ to 
denote a billing batch, followed by a sequential number beginning at 00001. 

 
 

Important 

When a Government Subsidy batch is created, only the payment 
relating to the $235 Education Program Allowance should be placed in 
this batch. No other payments are to be entered. 
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Activity: Receipting Overpayments 
 
Rhys Fitton wishes to pay $570 by cheque for his Charges and Contributions.  Currently his 
Billing Items total $270.00.  The overpayment will be processed as unallocated credit. 

RM Billing > Receipts 

 Double click on the General Banking Batch receipts batch 

 Select the Bulk Receipts tab 

 Click Add Receipts   

 Type Fitton and <Tab> to select him 

 Type 570 in the amount 

 <Tab> in the items field and select all items  
 

 
 

 Click OK 
 

 
 

 Click Yes 

 <Tab> in the Type column and select CH 

 Type in comment Balance of Account 
 

 
 

 Click OK 

Note: The overpayment will be recorded as unallocated credit within Rhys Fitton’s record.  
When this Receipts batch is entered into RM Finance, this amount will be posted against 
the Billing Suspense Account N3199. 
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5.4.1 Bulk Receipting for Charges and Contributions (via Students > Apply Receipts) 

This method is useful if a group of students are all paying the same amount for charges and 
contributions.  The system will automatically allocate the entered amount to each student to pay 
off their Billing Items in a specified order, according to regulations.  If the amount of the receipt is 
greater than the amount owing for the specified categories, then the additional amount will become 
unallocated credit (i.e. a credit amount which is not assigned to any billing items). 
 
Billing Items will be paid off in the following order:   
 

Student Billing Category Priority for applying receipts 

Kindergarten, Pre-Primary, 
Primary, Secondary (Vol,Chg) 

Charges, Residential, Voluntary, Other Optional Costs, 
Voluntary Approved Requests followed by any other item which 
has a category assigned including Not Applicable. 
   

Secondary (Chg) Charges, Residential, Other Optional Costs, Voluntary 
Approved Requests followed by any other item which has a 
category assigned including Not Applicable. 
 

Temporary Visa Overseas 
Students 

Temp Visa, Charges, Residential, Other Optional Costs, 
Voluntary Approved Requests followed by any other item which 
has a category assigned including Not Applicable. 
 

Adult Students Adult Student Costs, Charges, Residential, Other Optional 
Costs, Voluntary Approved Requests followed by any other 
item which has a category assigned including Not Applicable. 
 

Full Fee Paying Overseas 
Students 

Charges, Residential, Other Optional Costs, Voluntary 
Approved Requests followed by any other item which has a 
category assigned including Not Applicable. 
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Activity: Entering Bulk Receipts for Charges and 
Contributions (via Students) 
 
The following students have all paid $270 for the balance of their Voluntary Contributions. The 
payments have been processed via EFTPOS.  Enter receipts for the student payments in the 
table below. 
 

Student Payment 

Ben Anderson $270 

Steven Bailey $270 

Michael Brogan $270 

Emily Gold $270 

 

RM Billing > Students  

 Use Student Find    to find all Year 10 students 

 Highlight the students listed in the table above 
 

 
 

 Click Select 
 

 
 Click Yes 
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 Highlight the students 
 

 
 

 Click For Selected > Apply Receipts  
 

 
 

 Click OK for Billing Year 2019 

 Enter the Electronic Funds Transfer receipts batch number or press <Tab> for a list 

 Type in the amount that will be applied to each student $270 

 Press <Tab> and select the payment type for EFTPOS or type EF 

 Enter a Comment 
 

 

 Click OK 

 Close the Students window 
 

IMPORTANT: The amount entered will be applied to each student 
record. In this example, none of the students selected have any 

charges within their Billing Items so the Voluntary Contributions are 
paid off. Users are advised to check student records before using the 

Apply receipts method.  This functionality can only be used when 
each student has paid the same amount  
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Activity: Printing Receipts for Bulk Entries 

RM Billing > Receipts  

 Double-click on the required batch (Electronic Funds Transfer) 

 Choose the Batch Receipts tab 

 Highlight the receipts to be printed at the top section of the screen 

 Click Print    > Yes > OK and OK to print to screen 

 View and close the receipts 
 

 With the receipts highlighted, click on Print and Yes 

 Select the Record of Receipt Allocations 
 

 
 

 View the Record of Receipt Allocations then close 
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5.4.2 Individual Receipting  

This method can be used to enter a receipt for an individual student. 
 

Activity: Individual Receipting 
 
Maureen Kent, Clayton Kent’s grandmother, has come to the front office to pay for his Subject 
Charges (not the Camp).  She has a cheque for $300. We will edit the received from details to 
reflect the payment from someone other than the Fees Biller 

RM Billing > Students 

 Double-click on the record for Clayton Kent 

 Select the Receipts tab 

 Click Add Receipt    
 

 Press <Tab> for a list of open receipts batches 

 Select the General Banking batch for today and Click OK 

 <Tab> to move to the Payment Type field 

 <Tab> to view a list of valid payment types (or type the code if you know it) 

 Select CH and Click OK 

 Enter 300 as the amount and <Tab> 
 

 

Note what happens to the applied amounts in the lower table. The receipt is allocated 
against the billing items from the top down. This can be changed if you only need to pay 
off a specific billing item. 
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 Enter the comment Balance of subject charges 

Note: The comment appears on the statement. 

 Edit the Received from details to read 

 Title: Mrs 

 First Name: Maureen 

 Surname:  Kent 

 Address: 45 Terrace Road, CLAREMONT  WA  6015  
 

 
 

 Click on OK to save 
 

Note: The ‘Received from’ fields on the Add Receipt screen show the name of the current 
fees biller for the student. If someone else is paying the money, these fields should be 
edited to contain the name and address of that person. These details are saved with the 
receipt. 
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5.4.3 To Print a Receipt 

Activity: Print a Receipt 

RM Billing > Students  

 Click on the Receipts tab 

 Highlight the receipt Balance of subject charges  

 Click Print   
 

 
 

 Choose Receipts > OK and OK to print the receipt to screen 

 View and close the Receipt 

 Click Print   

 Choose Record of receipt allocations > OK and OK to print the receipt to screen 
 

 View and close the Record of Receipt Allocation 
 

Note: The official document is the ‘Receipt’. This is what should be printed and given to the 
parent.  

The ‘Record of Receipt Allocation’ can also be printed if required. This lists the billing items 
to which the receipt is currently allocated. Note that the allocations for a receipt can change 
if paid billing items are reversed or adjusted or if unallocated credit is allocated. 
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5.4.4 Original/Draft/Copy text on Receipts 

To obtain an original receipt, the receipt must be printed directly to the printer (not to the screen 
and then to the printer). 
 
Receipts printed directly to the printer for the first time will contain no additional text. 
Receipts viewed to the screen will contain the text ‘DRAFT’. If sent to the printer from the screen, 
the printed copy will contain the text ‘DRAFT’. 
Receipts printed to the printer for the second or subsequent time will contain the text ‘COPY’. 
 
The above is an important audit consideration as there should only ever be one original receipt 
created. 
 

 
  

 

 
 
To move to a new record right click in the Surname cell.  Enter the surname for the next required 
record. 
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Activity: Review of Entering Individual Receipts 
 
Enter the following receipts into RM Billing using the individual receipting method outlined above. 
 
1. Dean Partington has come to the front office to pay for the Camp charges. He has a cheque 

for $300.  Make sure you allocate the money to the camp. (You will need to change the 
automatic allocations). Print the receipt to screen. 

 

 
 
2. Donna Ravat has brought a cheque for $200 to pay a portion of her subject charges. Print 

the Record of Receipt Allocations to screen. 
 

 
 
 
3. Cory Ramsay has come to the office with $20 cash to purchase the School Year Book.  

Make sure you allocate the money to the School Year Book item. Print the receipt to screen. 
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5.5 Receipting for Customers 

Individual receipts can be created for a particular customer. This is done via the Customers section 
by drilling down on the Customer record and going to the Receipts tab. 
 

Activity: Receipting Customer 1 
 
West Coast Theatre has paid for the hall hire for weeks 1-5.  The money has been paid directly 
into the bank using EFTPOS via the schools on-site machine.  Print a copy of the receipt for 
West Coast Theatre. 

RM Billing > Customers 

 Open West Coast Theatre 

 Select the Receipts tab 

 Click Add Receipt   

 Press <Tab> in the Batch No field and select the Electronic Funds Transfer batch 

 Enter the payment type of EF or press <Tab> for a list 

 Accept the default date 

 Enter the amount of 550 

 Enter a Comment (e.g. Hall Hire Term 1 Weeks 1-5) 

 Check that the applied amount is correctly allocated in the lower window 
 

 
 

 Click OK 

 Highlight the receipt 

 Click Print   

 Select Receipts and OK and OK to print the receipt to screen 

 View and close the receipt and Return to View   
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Activity: Receipting Customer 2 
 
Oceanview Tennis Club have paid in advance for their first week of tennis court hire with a 
cheque for $240.  Process the payment for the Oceanview Tennis Club. 

RM Billing > Customers 

 Open Oceanview Tennis Club 

 Select the Receipts tab 

 Click Add Receipt   

 Press <Tab> in the Batch No field and select the General Banking Batch 

 Enter the payment type of CH or press <Tab> for a list 

 Accept the default date 

 Enter the amount of 240 

 Enter a Comment (e.g. Tennis Court Hire Week 1) 

 Check that the applied amount is correctly allocated in the lower window 
 

 
 
 

 Click OK 
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6 Manually Closing the Batch (Non Exporting Schools) – 
Discussion Only 

Once the banking has been finalised, the receipts batch/es must be manually closed to ensure that 
no more receipts are processed through them and the contents of the batch manually entered into 
RM Finance. This should only be done when you are ready to finalise the banking and close off 
the batch – i.e. no further receipts should be entered into this batch once this process has 
commenced. .  A new receipts batch can be opened with the same format and using the current 
date of opening (eg. General Banking 30.01.19) 
 
In training today, we are exporting our batches to RM Finance, so we do not need to manually 
close them.  This is done automatically as part of the Export to RM Finance process.  The following 
is a guide for those schools not yet exporting. 
Manual Input of Receipts to RM Finance (Discussion Only) 
 

RM Billing > Receipts 

 Highlight the batch to be closed 

 Click For Selected > Print Daily Banking > OK 
 

 

 

 
 This report can be used to check the calculations of your totals to be banked 

 Print a paper copy of the report and file it  
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6.1.1 Print the Receipts Summary Detailed Report – Discussion Only 

The Receipts Summary Detailed Report must be printed and filed.  It displays a list of all 
transactions within the batch. 

RM Billing > Receipts 

 Highlight the batch to be closed 

 Click For Selected > Print Receipts Summary 

 Click OK to the Screen 
 

 
 

 Click on Yes to view the detailed Summary 
 
A portion of the report is displayed below 
 

 
 
This report should be printed to the printer and filed for reference 
 

Note: The ‘Totals Only’ version of the Receipts Summary report is recommended for the 
manual input of data into RM Finance, however the detailed summary must be printed and 
filed for reference. 
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6.1.2 Print the Receipts Summary Totals Only Report – Discussion Only 

The ‘Totals Only’ version of the Receipts summary report is used to input the data into RM 
Finance. This report is printed when the batch is closed.  The report is broken up via the various 
billing codes.  The budget and analysis code is displayed for each billing code as well as the total 
for each budget and analysis code.  Receipts which contain GST are separated from those which 
do not have GST. 
 

RM Billing > Receipts 

 Highlight the batch to be closed 

 Click For Selected > Print Receipts Summary 

 Click OK to the Screen 
 

 
 

 Click on No Totals Only 
 

 
 

 This report is automatically sent to the printer.  There is no provision to print it to the screen. 
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6.1.3 Manually Closing Receipt Batches in RM Billing – Discussion Only  

RM Billing > Receipts 

 Highlight the batch to be closed 

 Click For Selected > Close Batch 
 

 
 

 
 

 Click Yes 

 The Print Setup screen appears 

 Check your settings and click on OK 
 

 
 

 Say Yes to print the Detailed Summary.  This must be printed and filed 

 Click No to get the Totals Only version of the report 

 Go to the printer and check that the report has printed successfully 
 

 
 

 If the report has not printed correctly click on ‘No’. Go back to the start of the ‘Close Batch’ 
process and repeat the steps listed 

 

 If the report has printed correctly click ‘Yes’ (ensure care is taken with the process of closing 
the batch and marking the transactions posted, as this cannot be reversed).  A working 
message may briefly appear. Then the batch is marked as closed, meaning that no further 
receipts can be placed in the batch 
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7 Exporting to RM Finance 
 
Exporting to RM Finance allows schools to export their Billing Receipts into RM Finance. 
All receipts (except Government Subsidies) which are entered into RM Billing need to be 
processed in RM Finance where reconciliation will take place. 
 
 Once the Export function has been enabled, the manual input of receipts batches into RM Finance 
is no longer required.  Once the banking has been finalised, the Export to RM Finance utility will 
transfer the contents of the selected batches into RM Finance.  As the batch is exported, it is 
automatically closed, so new banking batches would need to be created to hold further takings. 
 
The same first steps as carried out for the manual input need to be carried out for the automatic 
export. 
 

 Print the Daily Banking Summary 
 

 Print the Receipts Summary (Detailed Report) 
 

Once the Daily Banking and Receipts Detailed Summary have been printed, the Export to Finance 
procedure can be initiated. 
 
On Export, a ‘Receipt Batch Export Summary’ Report will be sent straight to the printer.  This will 
include a list of exported batches, followed by a breakdown of the type of batches exported and a 
total of each batch.   
 
If exporting EFT batches, a system generated Batch number will be produced for the export eg: 
RMB00001EFT. 
 
Before Exporting, RM Finance must be closed. If RM Finance is open, an error message ‘Too 
many records to sort” may be received, which will prevent the export from proceeding.  Once RM 
Finance is closed and the export complete, the user can log back into RM Finance to print the 
Batch Transaction report and update the batches. 
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Activity: Print Daily Banking 
 
The General Banking and EFTPOS batches are ready to be closed and the money banked. 
The Daily Banking Summary and the Receipts Summary Detailed Summary must be printed for 
both batches. 
 

RM Billing > Receipts 

 Highlight the General Banking receipts batch 

 Click For Selected > Print Daily Banking 
 

 

 
 
 

 View and close the Daily Banking Summary 
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Activity: Print Receipts Summary  
 
Print the Receipts Summary for the General Banking receipts batch for today. 

RM Billing > Receipts 

 Highlight the General  Banking receipts batch 

 Click For Selected > Print Receipts Summary 
 

 
 

 Click Yes 
 

 
 

 View and close the Summary Detailed Receipts Report  
 

Note: The Detailed Receipt Summary must be printed as part of the batch closing routine 
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Activity: Print Daily Banking 

RM Billing > Receipts 

 Highlight the Electronic Funds Transfer receipts batch 

 Click For Selected > Print Daily Banking 

 Click OK to the screen 
 

 
 

 View and close the Daily Banking Summary 
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Activity: Print Receipts Summary 
 
Print the Receipts Summary Detailed Report for the Electronic Funds Transfer receipts batch for 
today. 

RM Billing > Receipts 

 Highlight the Electronic Funds Transfer receipts batch 

 Click For Selected > Print Receipts Summary 

 Click Yes to print the Detailed Summary 

 Click Ok to the screen 
 
A portion of the report is displayed below 
 
 

 

 
 View and close the report 
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7.1 Exporting the Batches 

Activity: Exporting to RM Finance 
 
RM Billing > Utilities >  
 

 Double click on Export to RM Finance 
 

 
 
 

 
 

 Click Yes 

 Highlight the General Banking and Electronic Funds Transfer batches 
 

 
 

 Click OK 

 Check the settings on the Print Setup screen and click OK (Do not cancel at this stage 
otherwise transactions will not be exported) 

 The export process will commence 
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 Click OK 

 Close the Utilities window 

 The Export Report is sent directly to the printer 
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Check the batches have been closed 
 
RM Billing > Receipts 
 
 

  
 
 

 View the two batches are now closed 
 
Once the batches have been exported, the user must log back into RM Finance to print the 
Batch Transaction Report and Update the batches.  We will not be doing this in training. 
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Billing Item  Corrections  
Adjustment This will create an adjustment 

transaction for the adjustment 
amount entered. This effectively 
reduces the amount of the billing 
item by the adjustment amount.  
 

 Used to adjust a billing item 
when the amount billed was 
too high. 

 
Note: An alternative method 
could be to reverse the item and 
then add a new billing item for a 
lower amount. 
 

Reversal This will create an opposite 
(reversal) transaction thereby 
‘cancelling out’ the billing item.  
 

 Used to correct an error (billing 
item should not have been 
created) 

Used when a student should no 
longer be charged for an item (e.g. 
billed for Camp but now not going) 
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8 Billing Item Reversals 
A billing item can be reversed if it has been entered in error, or if the student should no longer be 
charged for that item. 
 

Activity: Reverse a Billing Item 
 
All the Year 11 students have been billed for the camp. We have now received notification that 
Donna Ravat is unable to attend as she has broken her arm.  As she should no longer be 
charged for the camp, all of her camp-related billing items will need to be reversed. 

RM Billing > Billing Items 

 Double click on the Year 11 Camp Billing Item batch 

 Click on the Batch Billing Items tab   
 

 Click on  (this ensures that the balances owing on the billing items 
after adjustments, if any are displayed) 

 

 

 Click   

 
 



 

 
RM Billing Sec Receipting Training Notes 2019 20-Mar-19 

Page 60 of 102 

   © 2019 Civica Education Pty Ltd 

 

 Click Yes to the message 
 

 Enter Reason commencing with the Month and Year   
 

 
 

 Click OK 
 
 
View the reversal 
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8.1 Timetabled Subject Changes 

 
Once the actual billing items have been created for Timetabled Subjects (via Utilities > Create 
Subject Billing Items) for a student, any subject changes made after that point in time will need to 
be reflected in RM Billing. 
 
The process for handling timetable changes involves: 
 

 Reversing the old subject billing item 

 Adding the new subject billing item 
 
If changes need to be made to the subject cost as a result of a partial competition of a course the 
process many involve: 
 

 Adjusting or discounting the old subject billing item 

 Adding and adjusting or discounting the new subject billing item 
 

Note:  To change the subject preferences is usually the task of the Timetabler at your 
school.    
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8.1.1 Timetabled Subjects and Subject Billing Items Reports 

To assist in the management of student billing, users are able to produce reports which will 
compare a Student’s subject listing with their billing items.  This allows users to easily identify 
subjects for which the student has not been billed, or existing billing items for subjects which the 
student is no longer enrolled. 
 

Activity 
 
The Timetabler has changed Sean Guthrie’s classes from Human Biology ATAR 11 to Modern 
History ATAR 11 
 
Changes to Sean Guthrie’s subject selection in Timetabling, has resulted in subjects Human 
Biology ATAR 11 with no billing items and billing items Modern History ATAR 11 with no 
subjects.  We are able to generate a report which will identify such changes and assist in the 
management of student billing.  

RM Billing > Reports > Transactional Reports > Timetabled Subjects and Billing Items  

 Click on New Query   

 Enter Guthrie in the Surname cell  
 

 
 

 Click on Print 
 
 

 
  



 

 
RM Billing Sec Receipting Training Notes 2019 20-Mar-19 

Page 63 of 102 

   © 2019 Civica Education Pty Ltd 

 

 

 
 

 View and close the Report 
 

 
  



 

 
RM Billing Sec Receipting Training Notes 2019 20-Mar-19 

Page 64 of 102 

   © 2019 Civica Education Pty Ltd 

 

Activity: Reversing a Subject Billing Item 

RM Billing > Students 

 Double click on Sean Guthrie 

 Select the Subjects tab 

 View the updated subjects 
 

 
 

 Select the Billing Items tab 

 Highlight the Human Biology ATAR 11 billing item 
 

 
 

 Click    
 

 
 

 Answer ‘Yes’ to the message 

 Enter the Month,Year and Reason - Moved to Modern History ATAR 11 
 

 
 

 Click OK 
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 View the Reversed Billing Item 
 

 
 
The student’s Billing Items screen can be viewed showing only Billing Items with Outstanding 

Balances by clicking on  
 

 Click on the Show Billing Items with Outstanding Amounts button 
 

 
 

 Note the reversed items have been hidden  
 

  



 

 
RM Billing Sec Receipting Training Notes 2019 20-Mar-19 

Page 66 of 102 

   © 2019 Civica Education Pty Ltd 

 

8.2 Adding New Subject Billing Items 

Activity:  Adding a Subject Billing Item 
 
Add the subject billing item for Modern History to Sean Guthrie.  
 

 Click  

 Choose Add Subject Billing Item and OK 
 

 
 

 Click OK to Billing Year 2019 
 

 
 

 Select Modern History ATAR 11 in the list of subjects for Sean Guthrie 
 

 
 

 Click OK and view the newly created subject billing item 
 

 

Note: It is recommended the Timetabler has Course Change Recording activated for each 
student in the Timetabling module.  This enables the course change history to be printed. 

  



 

 
RM Billing Sec Receipting Training Notes 2019 20-Mar-19 

Page 67 of 102 

   © 2019 Civica Education Pty Ltd 

 

8.2.1 Printing an Updated Statement for the Student 

Activity: Print Statement 
 
Print an updated statement for Sean Guthrie. 

RM Billing > Students 

 

 Click Return to View  

 Start typing Guthrie 
 

 Highlight Sean Guthrie 

 Click For Selected > Print Statement 

 Click OK 
 

 View and close the new statement 
 

 
 
 

IMPORTANT  

Billing Items do not change automatically and need to be reversed 
and/or adjusted as required. 
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8.2.2 Reversing Subject Billing Items which have been Receipted 

At times a student may have already paid for a subject or the subject may have been paid for by a 
government subsidy.  It may be necessary to reverse this billing item and create a new billing item 
for a new subject.  In this instance the receipted amount will become unallocated credit and must 
be manually allocated to a new billing item. 
 

Activity: Print Timetabled and Subjects and Billing Items 
Report 
 
David Maroney’s Earth and Environmental Science subject has been paid by the EPA.  He has 
now changed his subject selection from Earth and Environmental Science to Economics ATAR 
11. We are able to produce the Timetabled Subjects and Billing Items Report to assist in 
updating his Billing Items 
 
Reports > Transactional Reports > Timetabled Subjects and Billing Items 
 

 Click  

 Type Maroney in the Surname/Ref No field 

 Click Find and select David 

 Click Print 
 

 
 

 View and close the report 
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Activity: Reverse a Receipted Billing Item 

RM Billing > Students 

 Double click on David Maroney 

 View the Subjects tab 

 Select the Receipts tab 

 Click on the receipt for the $235 Imported Educational Program Allowance 
 

 
 

 View the details down the bottom of the screen showing that Earth and Environmental 
Science has been receipted 
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 Select the Billing Items tab 

 Highlight the Earth and Environmental Science Billing Item 
 

 
 

 Click Reversal > Yes 

 Type the Month, Year and reason for Reversal   
 

 
 

  Click OK 

 View the unallocated credit of $50.00 
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 Click Add Billing Item 

 Select Add Subject Billing Item > OK 

 Click OK to the Billing Year of 2019 

 Select Economics ATAR 11  in the list of subjects  
 

 
 

 Click OK 

 Click on  
 

 
 

 Highlight the Economics ATAR 11  billing item 
 

 Click Allocate  

 Enter 50.00 in the amount to allocate and click OK 
 

 
 

 Click on the Receipts Tab 

 Highlight Imported EPA receipt and note that Economics has now been receipted 
 

Note: Transactions which have been Reversed (R) or are the Reversal Transaction (V) 
cannot be reversed. Transactions which have been Adjusted (A) or are the Adjustment 
Transaction (T) cannot be reversed  
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8.3 Billing Item Adjustments 

An adjustment can be used to reduce a billing item amount.   
 

Activity: Adjust a Billing Item 
 
We have received notification that Julie Pilter will be providing her own transport to the camp 
(one way only). The school has agreed to charge only half the transport cost for the camp.  

RM Billing > Students 

 Click into the red Surname Cell right click enter Pilter 

 Select the Billing Items tab 

 Highlight the Camp Transport billing item 

 Click   
 

 
 

 Click Yes 

 Enter half the amount (25.00) into the ‘Adjust down by’ field 

 Enter the Month, Year and  a Reason (e.g. Providing own transport one way)  
 

 
 

 Click OK 

 View the adjustment in the billing items list 
 

 
 

Note: An alternative way to achieve the above would be to apply a 50% discount to the 
Camp Transport billing item. 
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9 Receipt Corrections 
The table below outlines the different correction options which are available for receipts.  
 

Receipt  Corrections  
Refund Used to refund amounts that 

have already been paid. 
 

 Used when money needs to 
be returned (refunded) to the 
parent. 

 
The associated billing items will 
be adjusted automatically so that 
the parent no longer owes the 
money. 

Reversal This will create an opposite 
(reversal) transaction thereby 
‘cancelling out’ the receipt 
 

 Used to correct an error 

 Used for cheques that are not 
cleared 

 Used for EFTPOS payments 
that have failed 

 
(Note that Billing item balances will 
be reinstated.) 
 

 
 

9.1 Receipt Reversals 

A receipt can be reversed for a number of reasons. If the original batch the receipt was processed 
into has been closed, then an alternative batch must be created to either hold the receipt or pass 
the receipt through to another record.  If a receipt is to be refunded and the original batch has been 
closed, then a Refunds batch must be created to hold the reversed receipt. 
 

9.1.1 Corrections Batch 

A Corrections batch would be created if the original batch the receipt was processed into has been 
closed and a receipt reversal is to be performed.  This could be because of user error resulting in a 
receipt having to be reversed or perhaps a cheque has been dishonoured by the bank, or a receipt 
has been applied against a wrong student record and therefore must be reversed and applied to 
the correct student. 
 
 
 

IMPORTANT 

A Receipt reversal will be posted into the same receipts batch as the 
original receipt, providing that receipts batch is still open.  However, if 

the original batch has been closed, you will be asked to select an 
alternative batch. The Corrections batch should be selected. 

 
  



 

 
RM Billing Sec Receipting Training Notes 2019 20-Mar-19 

Page 74 of 102 

   © 2019 Civica Education Pty Ltd 

 

10 Refunds 
 

10.1 Refund Batches 

A Refunds batch would be created if money which has been paid, needs to be returned (refunded) 
to a parent/guardian.  Refund batches must be identified according to the type of refund eg: EFT, 
System Generated Cheques or Manual written cheques.  If processing EFT refunds, the batch 
would be named Refunds – EFT dd/mm/yy etc. 
 
Unlike a General Banking batch or an EFT batch which may stay open until the banking is ready to 
be finalised, both the Corrections and Refunds batches are closed as soon as the Correction or 
Refunds have been completed. 
 

Non Exporting Schools 

Schools which are not exporting to RM Finance may write manual cheques or produce system 
generated cheques which can be created when the expenditure transaction is entered into RM 
Finance. 
 

Exporting Schools 

Schools which are exporting to RM Finance have the option of refunding through a Manual 
Cheque, a System Generated Cheque or through EFT.  This functionality is only available for 
Students at this time and not for Customer refunds.  Customer refunds must be made through a 
manual written cheque. 
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Activity:  Create Refund Batches 
 
West Coast Theatre has paid for the Hire of the Hall for weeks 1-5 of Term1. They have 
informed us that they will not be using the hall over this period and have requested a full refund. 
The school has agreed to this refund and will issue a manual cheque with chq number 123568.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                            
 
Paul Hogan has been banned from attending the Year 11 Camp due to bad behaviour.  The 
school has agreed to refund the money to Mrs. Hogan and will issue her with a system-
generated cheque. 
 
Simon Rumble’s father has contacted the school to inform them that Simon is ill and cannot 
attend the camp. He has already paid in full and has asked for a full refund to be deposited into 
his bank account.  
 
Create the following three receipts batches using today’s date.  
 

 Create 3 Refunds batches for the following: 
 

o Manual Cheque (WCT)  dd/mm/yy 
o System Cheque (Paul Hogan) dd/mm/yy 
o EFT (Simon Rumble) dd/mm/yy 

 

RM Billing > Receipts 

 

 Add Item  
 

 
 

 Click OK 
 

 Add Item  
 

 
 

 Click OK 
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 Add Item  
 

 
 

 Click OK 
 
The batch numbers should be recorded on the Finance Batch Register 

 

 

Activity:  Create a Corrections Batch 
 
A payment of $300.00 for Year 11 Camp was incorrectly processed against the billing items for 
Renee Dexter.  The receipt should have been processed against Caitlin Davies.  The receipt will 
be reversed from Renee Dexter’s record and re-entered for Caitlin Davies. As the original batch 
is now closed, a Corrections batch must be opened to process the receipt from Renee Dexter to 
Caitlin Davies. 

RM Billing > Receipts 

 Add Item   

 Type Corrections and Today’s date 

 

 
 

 Click OK 

 

 Close the Receipts window 
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10.2 Receipt Reversals 

Activity: Reverse a Receipt 
 
A payment of $300.00 for Year 11 Camp was incorrectly processed against the billing items for 
Renee Dexter.  The receipt should have been processed against Caitlin Davies.  The receipt will 
be reversed from Renee Dexter’s record and re-entered for Caitlin Davies. 

RM Billing > Students 

 Double-click on Renee Dexter 

 Select the Receipts tab 

 Highlight the $300 receipt for the camp 
 

 
 

 Click   
 

 
 

 Click Yes 

 Enter a Month, Year and Reason for the reversal (e.g. Error – should have been applied to 
Caitlin Davies) 

 

 
 

 Click OK 

 Select the Corrections batch and Click OK 
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 View the reversal transaction 

 

 

Apply the Receipt to Caitlin Davies 

 

 Load Caitlin Davies’ records (Hint, right click in Surname field) 

 Select the Receipts Tab 

 Click on Add Receipt 

 Press <Tab> Select the Corrections Batch and OK 
 

 
 

 Continue entering the receipt for Caitlin Davies as per the screen shot below ensuring you 
apply it to the Camp Billing Items and NOT other charges. 
  

 
 

 Check that the final balance equals $300 

 Click on OK 
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Activity: Reversing an EFTPOS Receipt 
 
An EFTPOS payment for Emily Gold has been rejected by the bank. As the EFT batch where 
the original transaction was processed has been closed, the Receipt will need to be reversed 
into the Corrections Batch 

RM Billing > Students 

 Open Emily Gold’s record (Hint: Right click and type Gold) 

 Go to the Receipts Tab 

 Highlight the Receipt for Voluntary Contributions 
 

 
 

 Click  

 Click Yes to the message 

 Type the Month, Year and a Reason 
 

 
 

 Click OK 

 Select the Corrections Batch 
 

 
 

 Click OK 

 View the Reversed Receipt 
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Activity:  Refund Manual Cheque 
 
West Coast Theatre has paid for the Hire of the Hall for weeks 1-5 of Term1. They have 
informed us that they will not be using the hall over this period and have requested a full refund. 
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RM Billing > Customers 
 

 Double-click on the West Coast Theatre Customer record 

 Select the Receipts tab 

 Highlight the receipt for 550 to be refunded 
 

 

 Click   

 Enter the refund amount of 550 

 Enter the reason for the refund 

 Enter the amount of the refund in the ‘Adjust by’ column 

 Select the correct refund billing code for Facilities Hire (press <Tab> in the ‘Ref Code’ field 
for a list) 

 Enter the manual cheque number 123568 in the ‘Cheque Number’ field 
 

 
 

 Click OK 
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 Select the Refunds – Manual cheque batch 
 

 
 

 Click OK 
 

 
 

 View the reversed transaction 
 

 Close the window 
 
 

 

Note:  Customers can only be refunded through manual cheques if exporting or manual or 
system cheques if not exporting.  

 

Note: The Customer Refund screen does not have the facility to enter a name in the 
‘Refunded To’ section. The refund will automatically be recorded against the customer 
name which cannot change (whereas the fees biller for a student can). 
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Activity:  Refund – System Cheque 
 
Paul Hogan has been banned from attending the Year 11 Camp due to bad behaviour.  The 
school has agreed to refund the money to Mrs. Hogan and will issue her with a system-
generated cheque. 
 
RM Billing > Students 
 

 Load Paul Hogan’s records 

 Go to the Receipts tab 

 Highlight the receipt for the Camp 
 

 
 

 Click Refund 

 Select System-Generated Cheque 
 

 
 

 Click OK 

 Enter the Refund Amount: of 300.00 
 

 
 

 <tab> twice 

 Mrs Hogan is not in the list of suppliers 

 Click  

 Enter the following 
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 Click OK 
 

 
 

 Click OK 
 

 
 Click OK 
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 Enter a Reason for Refund: Paul is not attending camp 

 Enter the Amount of the refund for each billing item in the ‘Adjust by’ column 
 

 
 

 Click OK 

 Select Refund – System Generated Cheque 
 

 
 

 Click OK 

 View the Refund details 
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Activity:  Refund - EFT 
 
Simon Rumble’s father has contacted the school to inform them that Simon is ill and cannot 
attend the camp. He has already paid in full and has asked for a full refund to be deposited into 
his bank account. 

RM Billing > Students  

 Right Click in the Surname field and enter Rumble 

 Select the Receipts tab 

 Highlight the receipt for the camp 
 

 Click   
 

 
 

 Select EFT  

 Click OK 

 Enter the refund amount of 300.00 

  <Tab> twice for a list of suppliers 
 
 (Note: Full or partial refunds can be entered) 
 

 
 

 Select Mr. Timo Rumble from the Refund To list 

 Click OK 
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 Enter the reason for the refund 

 Enter the EFT Reference (this is the initials of your school) 

 Enter the Amount of the refund for each billing item in the ‘Adjust by’ column 

 Select the correct Refund Billing Code for Charges (press <Tab> in the ‘Ref Code’ field for 
a list) 

 

 
 

 Click OK 

 Select the Refunds EFT batch 
 

 
 

 Click OK 

 View the Refund details 
 

 
 

 Close the student window 
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11 Unallocated Credit 
If money has been receipted against a billing item and the billing item is reversed or adjusted, the 
money assigned to these items will become unallocated credit.   
 
If money is receipted before any billing items have been created then this money will be 
unallocated credit. 
 
Unallocated credit can either be refunded or can be used to pay for other billing items for the 
student in accordance with the parent’s instructions. 
 

Activity: Review Unallocated Credit 
 
Rhys Fitton has unallocated credit due to an overpayment made earlier.  This amount currently 
appears on the Unallocated Credit Report.  We have been advised that the payment relates to 
the Year 11 Camp which Rhys will be attending.  If the original batch the receipt was processed 
into was still open, RM Billing would automatically reflect these changes in the batch. However 
the batch is closed, in which case users must print and post the Reallocation Report and enter 
these changes into RM Finance. (We will not being this in training) 

RM Billing > Reports > Financial Reports 

 Select the Unallocated Credit Listing Report 

 Sort by Form 

 Click Print 
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Add the Billing Items and Apply the Unallocated Credit 

RM Billing > Students 

 Open the record for Rhys Fitton 

 Click on the Billing Items tab 

 Click on Add Billing Item 

 Select to Add to Billing Item Batch  
 

 
 

 Click OK to 2019 

 Select the Year 11 Camp  
 

 
 

 Click OK 

 Highlight the three 2019 Camp billing items 
 

 
 

 Click  

 Allocate the $300 against the Camp billing items 
 

 
 

 Click OK 
 

Note:  Reallocations processed for receipts in a batch that is open will automatically be 
reflected in that batch. If the reallocation of a receipt occurs and the batch is closed, then 
the Reallocation Report must be printed and posted.  The reallocation transactions must be 
entered into RM Finance. 
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11.1.1 Auto Allocate via Billing Item Batch 

Activity: Auto allocate 
 
Prior to the creation of a billing item for the Museum of WA Excursion, we had receipted 
payments from a number of students who had already received a Friends of the Museum 
discount.  These payments were processed as unallocated credit.  Now the Billing Item for the 
Museum has been created, it can be applied to the students who had paid in advance. 
 
The unallocated credit of $12.50 can then be allocated using the auto allocate function within the 
billing item batch. 
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Activity:  Auto Allocate Unallocated Credit 

RM Billing > Billing Items 

 

 Double click on the Museum of WA Excursion billing item batch 

 Click on the Billing Batch Items tab 
 

 Click on (this ensures that the balances owing on the billing items 
after adjustments, if any are displayed) 

 Click on the Balance Header to sort by outstanding balance and highlight the students with 
an outstanding balance of $12.50 

 
The following students should be highlighted 
 

 Chelsea Kraft 

 Khalid Moor 

 Cory Ramsay 

 Bradley Uifelean 
 

 
 

 Click on  Auto allocate credit to the selected billing items 
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 Click Yes 
 

 
 

 Click OK and OK if the report has printed correctly 
 

Note: This report prints directly to the printer. It can be reprinted from Reports > 
Transactional Reports 

 
The Unallocated credit has now been applied. 
 

  
 

 Close the Billing Items screen 
 
 

  



 

 
RM Billing Sec Receipting Training Notes 2019 20-Mar-19 

Page 92 of 102 

   © 2019 Civica Education Pty Ltd 

 

Activity: View the Auto Allocate Report 

Reports >Transactional Reports 

The Auto Allocate Report can be re-printed from the Reports screen 
 

 Open the Transactional Reports folder 

 Highlight the Re-Print Auto Allocate Transactions 

 Highlight the report with today’s date 
 

 
 

 Click Print and OK to send the report to the screen 
 

 
 

 View and close the report 
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Warning:  The previous activity demonstrates a simple application of 
unallocated credit.  Schools must apply unallocated credit in 
accordance with the receipting business rules. This process should 
only be undertaken by staff after completion of the RM Billing Stage 2 
Training Course or with the guidance of your Senior Finance 
Consultant. 
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12 Follow-up of Unpaid Debts 
There are a number of reports within the system which can be used to assist with the follow up of 
unpaid debts. 

12.1 Printing Outstanding Items from the Billing Items batch 

Outstanding billing items can also be identified by looking at the billing items batch. 
 

Activity: Print a Report for Outstanding Billing Items 
 
Print a list of outstanding billing items for the Year 11 School Year Book batch. 

RM Billing > Billing Items 

 Double-click on the School Year Book batch 

 Click on the Batch Billing Items tab 

 Click Show Outstanding Amounts  (this ensures that the balances 
owing on the billing items after adjustments, if any are displayed) 

 Click  Filter the Billing Items against a search criteria 

 Place a tick in the Balance box 

 Select Balance > 0.00 
 

 
 

 Click OK 
 
All items with a Balance > $0 will be highlighted 
 

 Click on the Student/Cust column header to sort alphabetically 
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 Click Print Selected  

 View and close the report 

 Close the Billing Items window 
 

Note: This report will always list the individual billing items whereas the previous report 
(Transaction Summary report) allows the overall totals per student to be displayed. 
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13 Statements  

13.1 Producing Statements for Students 

In RM Billing an individual statement can be produced for each student.  Student statements can 
be accessed from two places: 
 

 Students > For Selected > Print Statement 

 Reports > Financial Reports > Statement – Students 
 

13.1.1 Printing a Statement from the Student List 

Activity:  Print a Statement 
 
Print a statement for Sean Guthrie. 

RM Billing > Students 

 Highlight Sean Guthrie 

 Click For Selected > Print Statement 
 

 
 
 

 The ‘From’ date will default to the first day of the current month. All transactions from this 
date onwards will be listed on the statement. Any transactions dated prior to this date will be 
summarised in an ‘opening balance’ figure. If this is the first statement you are sending to the 
parent/guardian then it is advisable to enter an earlier date so that all transactions for the 
current year are listed 

 The ‘To’ date will appear blank but will default to today’s date if left blank. Otherwise an end 
date may be entered. Transactions dated after the ‘To’ date will not be included on the 
statement 

 The default message that you entered in the Billing Parameters section will be displayed. 
This can be edited at this point if required but the changes will be used for this statement run 
only and will not be saved down 

 Accept the default entries for the training course and click on OK 

 View and close the statement 

 Close the Students window 
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Note: A summary table will be printed at the bottom of the student statement. This will 
categorise ALL amounts outstanding, (regardless of the dates you may have entered for the 
date range), by billing year and category.  This method can also be used to print statements 
for multiple students.  Students can be selected by using the find tool or by sorting on 
column heading and then highlighting the required students. 

 

13.1.2 Print Statements for Outstanding Debtors 

Statements can be produced only for those students with outstanding debt. 
 

Activity: Print Statement for Outstanding Debtors 
 
Produce Student Statements in alphabetical order. 

RM Billing > Students 

 Click on the Balance heading twice to bring those students with outstanding balances to the 
top of the list 

 Highlight the students with a balance > 0 

 Click on Hide unselected   

 Click on the Name header to sort the student into alphabetical order 

 Highlight all the students (Ctrl A) 

 Click For Selected > Print Statement 

 Enter From date 1 JAN 2019 and click OK 

 View and close the statements 

 Close the Students window 
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13.2 Customer Statements 

Statements for customers can be printed from the Reports section as follows. 
 

Activity: Print a Customer Statement 
 
Print a statement for West Coast Theatre. 

RM Billing > Reports 

 Open the Financial Reports folder 

 Select the Statement – Customers report 

 The date range and the message operate as outlined in the student statement 

 Click Find Customer   
 

 
 

Note: The customer can be searched for using the customer name field and the search 
button. 

 

 Select West Coast Theatre 

 Accept the default settings for the training course 

 Click Print 

 View and close the Statement 

 Close the Reports window 
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14 Support (Transactional) 
 
Should you require any transactional support, please contact Financial Operations Support at 
 
Contact details below: 
 
 

Email (BSC) 

Financialservices.support@education.wa.edu.au 
 
 

15 Support (Systems) 
 
Should you require any systems support, please contact the Customer Service Centre (CSC) at 
the Department of Education 
 
Contact details below: 
 

Phone (CSC) 

Metro:      9264 5555 
Country:  1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem 
 

FAX (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem 
 

Email (CSC) 

customer.service.centre@det.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem 
 
 
 
 
 
 
 
 
 

mailto:Financialservices.support@education.wa.edu.au
mailto:customer.service.centre@det.wa.edu.au
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16  Online Manuals and Training Notes 

16.1 Civica Education 

Online manuals and training notes are available to download in PDF format from the Civica 
Education website. 
 
http://www.civicaeducation.com.au/ 
 
Select Integris Support. 
Log in to Western Australian SIS Schools. 
Username: school 
Password: help 

16.2 STIMS Project 

The Department’s Student Information Management Project (STIMS) website has numerous 
factsheets and support documents for all SIS Administration modules. 
 
http://www.det.wa.edu.au/intranet/stims  
 
Links to the Integris Manuals are also available from the STIMS website or by going to Help within 
Integris. 
 
 

17 Finance Web 
 
http://det.wa.edu.au/finance/detcms/portal/ 
 
Log on to the DET Portal to access the latest factsheets  
 
RM Billing - Quick Reference Guide and FAQ  
RM Billing - Procedures for RM Billing Receipts Batches   
RM Billing - Using RM Billing _Alternative Method for Timetabled schools Yrs 8 10 . 
  

http://www.civicaeducation.com.au/
http://www.det.wa.edu.au/intranet/stims
http://det.wa.edu.au/finance/detcms/portal/


 

 

 

DEPARTMENT OF EDUCATION 

BATCH REGISTER 

     For the month of                                                                            Period      

     BANK RELATED TRANSACTIONS       

Batch No 
Date/D

ate 
Export 

Reference No   

Bank 
A/C 

1, 2, 3 

Income 
Receipts 

(INC) 

Expend 
Payments 

(ESP) 

Credit 
Notes 

Adjustments/Reversals ** 

Internal 
Charge** 

Accruals 
(Manual 

Only) 

BA/Vire 
Totals 

Proc 
By From To 

Type of  
Batch* 
[C] Cheque 
[E] EFT 
[B] BPay 

 

Income 
(I/C) 

Expend  
(ESC) 

          
  
         

               

               

                   

          
  
         

          
  
         

          
  
         

          
  
         

               

          
  
         

               

                  
  
  

  
          

                  
  
  

  
          

                

                

                

 

*Reversals and internal charges are not batched but must be recorded.  Billing batches are prefaced with a ‘B’.  Accruals are entered if manually 
processed. 


